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Introductions

Instructor

Dr. Steffi LaZerte
e Background in Biology (Animal Behaviour)
e Working with R since 2007

e Professional R programmer/consultant
since 2017




Introductions

Assistant

Dr. Alex Koiter

e Physical Geographer

e Working with R since 2010

e Assistant Professor in Geography and
Environment, Brandon University




What about you?

e Name

e Background (Area of study, etc.)

e Familiarity with R (or other programming languages)
o I've heard of R

o I've used R
o JTuse R all the time
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1. A little about R
2. Creating figures with ggplot2
3. Combining figures with patchwork

4. Saving figures
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Outline

1. A little about R
2. Creating figures with ggplot2
3. Combining figures with patchwork

4. Saving figures

Taken this or a similar workshop before?
During activities consider...
 Extra activities labeled "Too Easy?"

e Using your own data
e Exploring other aspects of ggplot2 that interest you

Feel free to ask questions even if it's not the "official" activity!
5796



What is R?




R is Programming language

A programming language is a way to give instructions in order to get a computer to do
something

e You need to know the language (i.e., the code)
o Computers don't know what you mean, only what you type (unfortunately)
e Spelling, punctuation, and capitalization all matter!

For example

R, what is 56 times 5.8?

56 * 5.8

## [1] 324.8
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Use code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?

mean(c(1l, 2, 3, 4))

## [1] 2.5
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Use code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?

mean(c(1l, 2, 3, 4))
## [1] 2.5

R, save this value for later

steffis_mean <- mean(c(l, 2, 3, 4))

8 /96



Use code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?
mean(c(1l, 2, 3, 4))

## [1] 2.5

R, save this value for later
steffis_mean <- mean(c(l, 2, 3, 4))

R, multiply this value by 6

steffis_mean * 6

## [1] 15
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# Get in circle around city

R iS ha rd circle <- data.frame()

cutoff <- 10

for(i in unique(gpsSregion)) {
n <=- nrow(gps[gpssregion == i,]) ##number of IDs

if(i == "wil") tmp <- geocode("Williams Lake, Canada")
if(i == "kam") tmp <- geocode("Kamloops, Canada")
if(i == "kel") tmp <- geocode("Kelowna, Canada")

temp <- data.frame()
for{(a in 1:n){
if(a <= cutoff) temp <- rbind(temp, gcDestination(lon = tmpSlon,
lat = tmp5lat,
bearing = (a*(366/(cutoff))-368/(cutoff)),
dist = 20,
dist.units = "km",
model = "WGS84"))
if(a = cutoff) temp =- rbind(temp, gcDestination{lon = tmpSlon,
lat = tmpSlat,
bearing = ((a-cutoff)*(360/(max(table(gpsSregion
})-18))-260/(max(table(gpsSregion))-cutoff)),
dist = 35,
dist.units = "km",
model = "WGSB4"))
1
circle <=- rbind(circle, cbind(temp,
region = 1,
hab = gpsShab[gpsSregion = 1],
spl = gpsSspl.orig[gpsSregion == 1], 9 / 96



But R is powerful (and reproducible)!

") Global Environment «

Data
O fish 172 ob .
O telem_total 12950046 obs.
Values

tz "Etc/GMT+8"
Functions

load_data function (x)

of 10 variables

L) O
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But R is powerful (and reproducible)!

") Global Environment «

Data
O fish 172 ob -
O telem_total 12950046 obs.
Values

tz "Etc/GMT+8"
Functions

load_data function (x)

(I made these slides with Rmarkdown)

of 10 variables
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R is also beautiful
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Why R?

R is affordable (i.e., freel!)

R is available as Free Software under the terms of the Free
Software Foundation’s GNU General Public License in source
code form. It compiles and runs on a wide variety of UNIX
platforms and similar systems (including FreeBSD and Linux),
Windows and MacOS.
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Impost R
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ImpostR Syndrome

Imposter Syndrome Reality

Impost |
i Syndrome

What | think others know

ﬂ What others know

David Whittaker
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ImpostR Syndrome

Imposter Syndrome Reality
Impost R
& Syndrome

What | think others know

e What others know

David Whittaker

Moral of the story?
Make friends, code in groups, learn together and don't beat yourself up
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https://github.com/allisonhorst/stats-illustrations

About R




Code, Output, Scripts

Code

e The actual commands

Output

e The result of running code or a script

Script

o A text file full of code that you want to run
e You should always keep your code in a script

17796



Code, Output, Scripts

Code

e The actual commands

Output

@ & analysis K

Script

o A text file full of code that you want to run
e You should always keep your code in a script

H M & || Sowrce on Save
e The result of running code or a script AT
niLtr setup
library(tidyverse)
libraryistringr)
library(aridExtra)
Libraryigrid)
library(boot)

counti(d,
count{d,
(Top Level} =

For example:

mean(c(1l, 2, 3, 4))

## [1] 2.5

= Aun

Q.o

theme_cust <- theme_bw(} +
theme(panel.grid = element_blank())

#' Load data
d =- read_csv("../DatafDatasets/pca.csv") =%
mutate{hab_c = ifelse(hab = @&, "Urban", "Rural"})

summary(dshab)

#' # Plotting
d_sum =-
group_by(hab_c) %=%
summarize{prop = sum(atypical_c) / length(atypical_c))

d ¥=%

d_n =- count(d, atypical_c, hab_c)

#' # Sample sizes

## @knitr sample_size
countid,
counti{d,
countid,

hab_c)
atypical_c)
lowhigh, monotone, freq_sweep)

region)
project = ifelse{str_detect(id, "MC[BC]{1}[®-9]{2}"), "Steffi",

v = Soure .| =

Code
Output

Script

17796
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RStudio vs. R

e RStudio is notR  Rotudio R

e RStudio is a User Interface or IDE (integrated development environment)
o (i.e., Makes coding simpler)

18796



functions() - Do things, Return things

mean(), read_csv(), ggplot(), c(), etc.

19796



functions () - Do things, Return things

mean(), read_csv(), ggplot(), c(), etc.

e Always have ()

e Can take arguments (think 'options’)
o mean(x = c(2, 10, 45)),
o mean(x = c(NA, 10, 2, 65), na.rm = TRUE)

19796



functions() - Do things, Return things

mean(), read_csv(), ggplot(), c(), etc.

e Always have ()
e Can take arguments (think 'options’)
o mean(x = c(2, 10, 45)),
o mean(x = c(NA, 10, 2, 65), na.rm = TRUE)
e Arguments defined by name or by position
e With correct position, do not need to specify by name

By name: By position:
mean(x = c(1, 5, 10)) mean(c(l, 5, 10))
## [1] 5.333333 ## [1] 5.333333

19796



R documentation

?mean

20/ 96



R documentation

mean {base} R Documentation
7mean

Arithmetic Mean

Description

Generic function for the (trimmed) arithmetic mean.
Usage

mean(x, ...)

## Default S3 method:

mean(x, trim = 0, na.rm = FALSE, ...)
Arguments
X An R object. Currently there are methods for numeric/logical vectors and date, date-

time and time interval objects. Complex vectors are allowed for trim = 0, only.

trim the fraction (0 to 0.5) of observations to be trimmed from each end of x before the
mean is computed. Values of trim outside that range are taken as the nearest
endpoint.

na.rm a logical value indicating whether NA values should be stripped before the
computation proceeds.

further arguments passed to or from other methods.
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Generally kept in vectors or data. frames

e These are objects with names (like functions)
e We can use <- to assign values to objects (assignment)

Vector (1 dimension) Data frame (2 dimensions)
my_data <- c("a", 100, "c") my_data <- data.frame(site = c("s1", "s2", "s3"),
my_data count = c¢(101, 102, 103),
treatment = c("a", "b", "c"))
## [l:l Ilall ||l®®|l IICII my_data
#i site count treatment
## 1 sl 101 a TS 2
## 2 s2 102 b columns
## 3 s3 103 C

21796



Your first real code!




First Code

# First load the packages
library(palmerpenguins)
library(ggplot2)

# Now create the figure
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

o Copy/paste or type this into the script window in RStudio
o You may have to go to File > New File > R Script

e Click anywhere on the first line of code
e Use the 'Run' button to run this code, or use the short-cut Ctr1-Enter
o Repeat until all the code has run
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First Code

# First load the packages
library(palmerpenguins)
library(ggplot2)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).
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First Code

# First load the packages

library(palmerpenguins) PaCkageS .
Library(ggplot2) ggplot2 and palmerpenguins

# Now create the figure
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).
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El 40 - ® Gentoo
ol

3000 4000 5000 6000
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First Code

Functions:
Library(), ggplot()
aes (), and geom_point()

# First load the packages
library(palmerpenguins)
library(ggplot2)

# Now create the figure
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).
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First Code

# First load the packages

library(palmerpenguins) . *
library(ggplot2) (Specific to ggplot2)

# Now create the figure
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).
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ol

3000 4000 5000 6000
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First Code

# First load the packages
library(palmerpenguins)
library(ggplot2)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).
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First Code

# First load the packages
library(palmerpenguins)
library(ggplot2)

# Now create the figure
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

, . o , Warning
## Warning: Removed 2 rows containing missing values (geom_point).

60 - ]
E species

| 50 -
g 2 ° e Adelie
(@]
E ® Chinstrap
El 40 - ® Gentoo
a

3000 4000 5000 6000
body mass g 29/ 96



First Code

# First load the packages Comments
library(palmerpenguins)

library(ggplot2)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).
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Now you know R!

Let's get started




Our data set: Palmer Penguins!

Artwork by @allison_horst ST 32/96



https://github.com/allisonhorst/stats-illustrations

almer

Our data set: Palmer Penguins! Bsensin:

library(palmerpenguins)
penguins

## # A tibble: 344 x 8

## species island bill_length_mm bill_depth_mm flipper_length_mm body_mass_g sex year
## <fct> <fct> <dbl> <dbl> <int> <int> <fct> <int>
## 1 Adelie Torgersen 39.1 18.7 181 3750 male 2007
## 2 Adelie Torgersen 39.5 17.4 186 3800 female 2007
## 3 Adelie Torgersen 40.3 18 195 3250 female 2007
## 4 Adelie Torgersen NA NA NA NA <NA> 2007
## 5 Adelie Torgersen 36.7 19.3 193 3450 female 2007
## 6 Adelie Torgersen 39.3 20.6 190 3650 male 2007
## 7 Adelie Torgersen 38.9 17.8 181 3625 female 2007
## 8 Adelie Torgersen 39.2 19.6 195 4675 male 2007
## 9 Adelie Torgersen 34.1 18.1 193 3475 <NA> 2007
## 10 Adelie Torgersen 42 20.2 190 4250 <NA> 2007

## # .. with 334 more rows GENTOO/ ADELigy

cwSIRAY
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almer

Our data set: Palmer Penguins!

library(palmerpenguins)
penguins

## # A tibble: 344 x 8

## species island bill_length_mm bill_depth_mm flipper_length_mm body_mass_g sex year
## <fct> <fct> <dbl> <dbl> <int> <int> <fct> <int>
## 1 Adelie Torgersen 39.1 18.7 181 3750 male 2007
## 2 Adelie Torgersen 39.5 17.4 186 3800 female 2007
## 3 Adelie Torgersen 40.3 18 195 3250 female 2007
## 4 Adelie Torgersen NA NA NA NA <NA> 2007
## 5 Adelie Torgersen 36.7 19.3 193 3450 female 2007
## 6 Adelie Torgersen 39.3 20.6 190 3650 male 2007
## 7 Adelie Torgersen 38.9 17.8 181 3625 female 2007
## 8 Adelie Torgersen 39.2 19.6 195 4675 male 2007
## 9 Adelie Torgersen 34.1 18.1 193 3475 <NA> 2007
## 10 Adelie Torgersen 42 20.2 190 4250 <NA> 2007

## # .. with 334 more rows GENTOO/ ADELigy

CASTRAP/
Sy

I Your turn! Run this code and look at the output in the console
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A basic plot

library(palmerpenguins)
library(ggplot2)

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point()
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Break it down

library(palmerpenguins)
library(ggplot2)

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point()

library(palmerpenguins)
e Load the palmerguins package so we have access to penguins data

35/96



Break it down

library(palmerpenguins)
library(ggplot2)

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point()

library(ggplot2)
e Load the ggplot2 package (which gives us access to the ggplot () function among others)

36 /96



Break it down

library(palmerpenguins)
library(ggplot2)

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point()

ggplot()
e Set the attributes of your plot
e data = Dataset
e aes = Aesthetics (how the data are used)
e Think of this as your plot defaults
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Break it down

library(palmerpenguins)
library(ggplot2)

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point()

geom_point()

e Choose a geom function to display the data
e Always addedto a ggplot () call with +

I ggplots are essentially layered objects, starting with a call to ggplot()

38 /96



Plots are layered

ggplot(data = penguins, aes(x =

6000 -

3000 -

] 1]
female male
sex

sex, y = body_mass_g))

geom_boxplot()

6000 -

ggplot(data = penguins, aes(x

= sex, y = body_mass_g)) +

3000 -

NA

]
female

male NA
sex
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Plots are layered

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) ggplot(data = penguins, aes(x
geom_point()

sex, y = body_mass_g)) +

6000 - ¥
6000 - $
9 5000 -
@ o 5000 =
o ®
= @ ®
X g s
©
3 4000 > °
3 3 H :
£ 4000 -
[ ]
3000 - i
3000 - s
s
1 [} 1 °
female male NA
1 [} 1
Sex female male NA

sex
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Plots are layered

ggplot(data = penguins, aes(x =

6000 -

3000 -

] 1]
female male
sex

sex, y = body_mass_g))

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
geom_violin()
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Plots are layered

You can add multiple layers

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
geom_boxplot()
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Plots are layered

You can add multiple layers

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
geom_boxplot() +

geom_point(size = 2, colour = "red")
6000 -
o 5000 -
’ ;
[4p]
[}
E|
> e
3 ¢ &
9 4000~
[ ]
3000 - I
1 ] 1
female male NA
sex
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Plots are layered

You can add multiple layers Order matters
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) + ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +

geom_boxplot() + geom_point(size = 2, colour = "red") +
geom_point(size = 2, colour = "red") geom_boxplot()

6000 - 6000 -
o 5000~ o 5000
! !
E| E|
= =
3 g . 3
Q 4000- Q 4000-

[ ]
3000 - I 3000 - 1
fen;ale mf'ile NIA fen;ale mf'ile NIA
sex sex
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Plots are objects

Any ggplot can be saved as an object

g <- ggplot(data = penguins, aes(x = sex, y = body_mass_g))

44 / 96



Plots are objects

Any ggplot can be saved as an object

g <- ggplot(data = penguins, aes(x = sex, y = body_mass_g))
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3000~

1 ] 1
female male NA
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Plots are objects

Any ggplot can be saved as an object

g <- ggplot(data = penguins, aes(x = sex, y = body_mass_g))

g g + geom_boxplot()
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More Geoms

(Plot types)




Geoms: Lines

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_Tline()
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Geoms: Histogram

ggplot(data = penguins, aes(x = body_mass_g)) +
geom_histogram(binwidth = 100)
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Geoms: Histogram

ggplot(data = penguins, aes(x = body_mass_g)) + Note: We only need 1
geom_histogram(binwidth = 100) aesthetic here (x)

20~

15-

count

2500 3500 4500 5500 6500
body mass g 47 /96



Geoms: Barplots

Let ggplot count your data

ggplot(data = penguins, aes(x = sex)) +
geom_bar ()

150 -

100 -

count

50 -

! 1]
female male

sex

NA
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Geoms: Barplots

You can also provide the counts

# Create our own data frame
species <- data.frame(species = c("Adelie", "Chinstrap", "Gentoo"),
n = c(152, 68, 124))

ggplot(data = species, aes(x = species, y = n)) +
geom_bar (stat = "identity")

150 -
100 -
c
50-
O -
Adelie Chinstrap Gentoo
species
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Your Turn: Create this plot

library(ggplot2)

ggplot(data = , aes(x = , Yy = )) +
geom_ ( )

]
20.0 - ‘
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_depth
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15.0-

] ] ]
Biscoe Dream Torgersen
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Showing data by group




Mapping aesthetics

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point()
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Mapping aesthetics

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +
geom_point()
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Mapping aesthetics

ggplot automatically populates the legends (combining where it can)

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex, shape = sex)) +
geom_point()
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Faceting: facet_wrap()

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +
geom_point() +
facet_wrap(~ species) Sp'lt plOtS by one
grouping variable
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Faceting: facet_grid()

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +
geom_point() +
facet_grid(sex ~ species) Spllt p|OtS by two
grouping variables
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Your Turn: Create this plot

ggplot(data = , aes( )) +
+
Adelie Chinstrap Gentoo

230~
£ 220-
=
I=) £ ‘ female
o 200 -
EI - male
- - -
2 180~

170 - ' ' i

female male female male female male NA
sex

Hint: colour is for outlining with a colour, fill is for 'filling' with a colour

Too Easy? Split boxplots by sex and island 57 / 96



Trendlines / Regression Lines




Trendlines / Regression lines

geom_1l1ine() is connect-the-dots, not a trend or linear model

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point() +
geom_Tline()
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Trendlines / Regression lines

geom_1l1ine() is connect-the-dots, not a trend or linear model

ggplOt(dat.atz)pf”gums, aes(x = body_mass_g, y = bill_length_mm)) + Nt \what we're
geom_poin i
A looking for
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Trendlines / Regression lines

Let's add a trend line properly
Start with basic plot:

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
geom_point()

g
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Trendlines / Regression lines

Add the Stat—smOOth() g + stat_smooth(method = "1m")

e Imis for "linear model" (i.e. trendline)
e grey ribbon = standard error
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bill_len

3000 4000 5000 6000
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Trendlines / Regression lines

Add the stat_smooth() g + stat_smooth(method = "lm", se = FALSE)
e remove the grey ribbon se = FALSE
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3000 4000 5000 6000
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Trendlines / Regression lines

A line for each group

o Specify group (here we use colour to specify species)

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()

g
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Trendlines / Regression lines

A line for each group

e stat_smooth() automatically uses the same grouping

g + stat_smooth(method = "lm", se = FALSE)
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Trendlines / Regression lines

A line for each group AND overall

g+

stat_smooth(method = "1lm", se

FALSE) +

stat_smooth(method = "1lm", se = FALSE, colour = "black")
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Your Turn: Create this plot

o A scatter plot: Flipper Length by Body Mass grouped by Species
o With a single regression line for the overall trend

I Too Easy? Create a separate plot for each sex as well
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Customizing plots




Customizing: Starting plot

Let's work with this plot

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
geom_point()
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Customizing: Labels

g + labs(title = "Bill Length vs. Body Mass",
x = "Body Mass (g)",
y = "Bill Length (mm)",
colour = '"Species", tag = "A")

Bill Length vs. Body Mass
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Customizing: Labels

g + labs(title = "Bill Length vs. Body Mass", .
_ ! Practice for later
x = "Body Mass (g)",

y = "Bill Length (mm)", Add proper labels to some of your
colour = "Species", tag = "A") previous plots

Bill Length vs. Body Mass
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Customizing: Built-in themes

g + theme_bw()
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Customizing: Axes

scale_ + (x ory)+ type (contiuous, discrete, date, datetime)

e scale_x_continuous()
e scale_y_discrete()
o etc.

Common arguments

g + scale_x_continuous(breaks seq(0, 20, 10)) # Tick breaks
c(0, 15)) # xlim() is a shortcut for this

g + scale_x_continuous(expand = c(0, 0)) # Space between axis and data

g + scale_x_continuous(limits
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Customizing: Axes

Breaks

g + scale_x_continuous(breaks = seq(2500, 6500, 500))
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Customizing: Axes

Limits

g + scale_x_continuous(limits = c (3000, 4000))
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Customizing: Axes

Space between origin and axis start

g + scale_x_continuous(expand = c(0, 0))
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Customizing: Aesthetics

Using scales

scale_ + aesthetic (colour, fill, size, etc.) + type (manual, continuous, datetime, etc.)

g + scale_colour_manual(name = "Type", values = c("green", "purple", "yellow"))
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Customizing: Aesthetics

Using scales
Or be very explicit:

g + scale_colour_manual(name = "Type",
values = c("Adelie" = "green", "Gentoo" = "purple", "Chinstrap" = "yellow"),
na.value = "black")
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Customizing: Aesthetics

For colours, consider colour-blind-friendly scale
viridis_d for "discrete"” data

ggplot(data = penguins, aes(x body_mass_g, y = bill_length_mm, colour = species)) +

geom_point() +

scale_colour_viridis_d(name = "Type")
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Customizing: Aesthetics

For colours, consider colour-blind-friendly scale
viridis_c for "continuous" data

ggplot(data = penguins, aes(x body_mass_g, y = bill_length_mm, colour = flipper_length_mm)) +

geom_point() +

scale_colour_viridis_c(name "Flipper Length (mm)")
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Customizing: Aesthetics

Forcing
Remove the association between a variable and an aesthetic

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +

geom_point(colour = "green", size = 5) +
stat_smooth(method = "lm", se = FALSE, colour = "red")
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Customizing: Legends placement

At the: top, bottom, left, right

g + theme(legend.position = "top")

species * Adelie ® Chinstrap ® Gentoo
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g + theme(legend.position c(0.15, 0.7))
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Combining plots




Combining plots with patchwork

Setup

e Load patchwork
e Create a couple of different plots

library(patchwork)

gl <- ggplot(data
geom_point()

penguins, aes(x bill_length_mm, y = bill_depth_mm, colour = species)) +

g2 <- ggplot(data penguins, aes(x species, y = flipper_length_mm)) +

geom_boxplot()

g3 <- ggplot(data penguins, aes(x flipper_length_mm, y = body_mass_g, colour = species)) +

geom_point()
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Combining plots with patchwork

Side-by-Side 2 plots

gl + g2
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Combining plots with patchwork

Side-by-Side 3 plots

gl + g2 + g3
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Combining plots with patchwork

Stacked 2 plots

gl / g2
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Combining plots with patchwork

More complex arrangements

g2 + (gl / g3)
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Combining plots with patchwork

More complex arrangements

g2 / (gl + g3)
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Combining plots with patchwork

"collect” common legends

g2 / (gl + g3) + plot_layout(guides = "collect")
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Combining plots with patchwork

"collect” common legends

g2 / (gl + g3 + plot_layout(guides = "collect"))
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Combining plots with patchwork

An nOtate Penguins Data Summary

g2 / (gl + g3) + “ 230-
plot_layout(guides = '"collect") + . |
220 -
plot_annotation(title = "Penguins Data Summary", E
. ; 3 210~
caption = "Fig 1. Penguins Data Summary", '*E, 1 |
tag_levels = "A", = 2
tag_suffix = ")") Eé 190-
= 180-
170~ . ! ; species
Adelie Chinstrap Gentoo .
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Fig 1. Penguins Data Summary
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Saving plots




Saving plots

RStudio Export
Demo
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Saving plots

RStudio Export
Demo

ggsave()

g <- ggplot(penguins, aes(x = sex, y = bill_length_mm, fill = year)) +
geom_boxplot()

ggsave(filename = "penguins_mass.png", plot = g)

## Saving 8 x 3.6 1in image
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Saving plots

Publication quality plots

e Many publications require 'lossless' (pdf, svg, eps, ps) or high quality formats (tiff, png)
e Specific sizes corresponding to columns widths
e Minimum resolutions

-+

g <- ggplot(penguins, aes(x = sex, y = body_mass_g))
geom_boxplot() +
labs(x = "Sex", y = "Body Mass (g)") +
theme (axis.text.x

element_text(angle = 45, hjust 1))

ggsave(filename = "penguins_mass.pdf", plot = g, dpi
height = 80, width = 129, units = "mm")

300,
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Wrapping up: Common mistakes

The package is ggplot2, the function is just ggplot()

Did you remember to put the + at the end of the line?

Order matters! If you're using custom theme ()'s, make sure you put these lines after bundled
themes like theme_bw (), or they will be overwritten

Variables like 'year' are treated as continuous, but are really categories
o Wrap them in factor (), i.e. ggplot(data = penguins, aes(x = factor(year), y =
body_mass_g))

94 /96



Wrapping up: Further reading (all Free!)

RStudio > Help > Cheatsheets > Data Visualization with ggplot2

ggplot2 book v3
o By Hadley Wickham, Danielle Navarro, and Thomas Lin Pedersen

Cookbook for R - by Winston Chang
o See also R Graphics Cookbook by Winston Chang

R for Data Science

o Data Visualization
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https://ggplot2-book.org/
http://www.cookbook-r.com/
https://r4ds.had.co.nz/
http://r4ds.had.co.nz/data-visualisation.html

Your Turn!

Create a figure with...

e Custom colour mapping (i.e. scales_....)

Clear, human-readable labels

More than one graph, each one tagged (e.g., A) or B))
With more than one geom type

At least one scatterplot with regression line

OR... Load your own data and create a figure of your own!
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